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About this document 
This guide is designed to assist the user in becoming quickly familiar with the capabilities of VisFlo, its 
interface and how the program is used.  
 
It has been produced to the recommendations of British Standard BS7649 – Guide to the design and preparation 
of documentation for users of application software. 

Trademarks 
All trademarks acknowledged. 
. 

Contacting PEL Support Services 
This program is developed, maintained and supported by PEL Support Services, ABB. We run a Hotline 
telephone and email service to answer any queries about VisFlo. 
 
Please let us have any suggestions on how you feel we could improve VisFlo. You can contact us by any of the 
following routes: 
 
By Telephone: ++44 (0)1925 74 1126 

By Fax: ++44 (0)1925 74 1265 

By E-mail: pel.support@gb.abb.com 

By Post: PEL Support Services 
ABB Ltd. 
Daresbury Park 
Daresbury 
Warrington 
Cheshire 
WA4 4BT 
United Kingdom. 
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Change history 
This table records the changes made to each new revision of this document. 
 
Changes to approved issues are indicated by a double revision bar on the outer margin next to the text. This is 
an example. 
 
Revision Date Description of change 
1.0 07 March 2000 First Approved Issue 
1.1 08 March 2001 Second Approved Issue. 

This issue completely replaces previous versions of this document as 
the user interface has been significantly upgraded. 

1.2 21 March 2001 Third Approved Issue (ABB logo added). 
1.3 10 October 2002 Fourth Approved Issue (Industrial IT logo & paragraph added, 

“Eutech” removed, Front page modified.) 
1.4 24 October 2005 Removed Industrial IT logo and paragraph. 
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1. VisFlo User Guide 

1.1. Introduction 
The VisFlo program can be used to perform pressure drop and heat transfer calculations on 
Newtonian and non-Newtonian liquids in pipe flow. 
 
The program has three modes of operation: 
 

Isothermal Pressure Drop VisFlo can be used to calculate pressure drop from flowrate 
or vice versa for isothermal flow in a pipe system. Both 
laminar and turbulent flow can be handled and a variety of 
pipe fittings are available. 

 
Laminar Flow Heat Transfer VisFlo can be used to calculate pressure drop and heat 

transfer for laminar flow in straight pipes. Either wall 
temperature or wall heat flux boundary conditions can be 
specified. 

 
Turbulent Flow Heat Transfer VisFlo can be used to calculate pressure drop and heat 

transfer for turbulent flow in straight pipes. 
 
Details of the calculation procedures for the three modes of operation are given in the relevant 
chapters of the non-Newtonian flow design guide. The fluid viscous properties are assumed to be 
described by the Generalised Bingham model: 
 

τ τ γ  =   + *Y
nK

 
where: 
 

τ − Shear Stress 

τY − Yield Stress 

K − Consistency Index 

γ − Shear Rate 

n − Flow Behaviour Index 

If τY = 0 − the model represents the well know power-law behaviour. 

If τY ≠ 0 and n = 1 − the model represents Bingham Plastic behaviour. 

If τY = 0 and n = 1 − the model represents a Newtonian fluid and K is the absolute 
viscosity. 
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In the laminar flow heat transfer calculation the consistency index is considered to be a function of 
temperature and defined by the equation: 
 

K K e0
n A

1
T

1
T0= * [ * *(  - )]

 
where: 
 

K0 = a reference consistency index at temperature T0 

A = the temperature dependence parameter (K) 
T0 = the reference temperature (K) 
T = the fluid temperature (K). 

 
Both τY and n are assumed to be independent of temperature. 
 
In the turbulent flow heat transfer calculation, the viscous properties are assumed to be 
independent of temperature. Fluid properties at the average bulk temperature should be used. 
 
In all three modes of operation the user has the option of supplying either the generalised Bingham 
model parameters described above or absolute viscosities for a Newtonian fluid. 
 
VisFlo uses SI units for input and output except that all temperatures including the reference 
temperature are in Degrees Centigrade. 
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1.2. How this guide is structured 
This guide is designed to assist the user in becoming quickly familiar with the capabilities of, its 
interface and how the program is used. 
 
The chapters are organised as follows: 
 

Chapter 1 An introduction to VisFlo. 

Chapter 2 Details the VisFlo user interface. 

Chapter 3 A tutorial to guide the user through a typical VisFlo session emphasising 
the commonly used features. It is recommended that the user should read 
this chapter while running the program. 
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2. The VisFlo User Interface 
The VisFlo user interface displays tabs that allow easy definition of the physical properties being 
calculated. The following sections of this chapter contains detailed information on the functions 
available with the dialogues assigned to these tabs. 
 
On-line documentation is available within the program. 

2.1. The VisFlo Start up Screen 
The VisFlo start up screen (see Figure 1) consists of the following: 
 

Menu Bar Displays the available options. 

Toolbar Buttons Descriptive text appears automatically as the cursor is held over the 
buttons describing their function. 

Tree View Display Used to store and retrieve calculations generated by the user or brought 
in from file. Click on the plus sign to expand the tree, the minus sign to 
collapse it and click on the calculation in the list to display it. 

Calculation Data 
Input Tabs 

Clicking on these tabs displays the input screens for the type of 
calculation selected. 

Display Calculation 
Results 

Displays the calculation results. 

Status Bar Displays program status information. 
 

Figure 1  VisFlo Start up screen 

The following sections of this chapter contain detailed information on the functions available 
within these tabs. 

Status Bar

Menu Bar

Tree View

Toolbar Buttons Calculation Data
Input Tabs

Display
Calculation

Results
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2.2. Isothermal Calculation 
Used to calculate pressure drop from flowrate or vice versa for isothermal flow in a pipe system. 
 
Click on the plus sign to expand the tree, the minus sign to collapse it and click on the calculation 
in the list to display it. 

Note. Clicking on a calculation from the tree view more than once will duplicate an instance of 
it and make it available for comparing results with slight modifications to input. 

 

Figure 2  Isothermal Calculation dialogue 

The following selections can be made from this dialogue: 
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Usage 
Description of 
calculation 

Mandatory 
Enter a text string to identify the calculation. 

Fluid Density Mandatory. 
The actual density of the fluid at operating temperatures. The units can 
be chosen as appropriate. 

Calculation Method Mandatory. 
Select the Calculation Method from either Newtonian Fluid or 
Generalised Bingham. 
The following selections are available when Newtonian Fluid is 
selected: 
Viscosity Settings 
•  Viscosity at Bulk Temperature. 
Calculation Mode 
Select either Flow Rate Fixed or Pressure Drop Fixed from the drop 
down menu. 
•  Flow Rate Fixed 

Enter values under Flow Settings for: 
- Flow Rate. 

•  Pressure Drop Fixed 
Enter values under Flow Settings for: 
- Flow Rate 
 - Pressure Drop 
- Flowrate Convergence. 

The following selections are available when Generalised Bingham is 
selected: 
Viscosity Settings 
•  TAUY 
•  K 
•  N 
Flow Settings 
•  Flow Rate 
•  Pressure Drop 
•  Flowrate Convergence. 

Calculate Performs the calculation and displays any results in the Results field. 

OK Saves the calculation and the entered data to the tree view. 

Results The field where the calculated results are displayed (see Figure 13 for 
an example). 
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2.2.1. Isothermal Calculation – Pipeline Details Tab 
Used to add Pipeline details for the Laminar calculation. 
 

Figure 3  Pipe Details dialogue 

The following selections can be made from this dialogue: 
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Usage 
Pipeline Details Mandatory. 

Enter values for: 
•  Inlet Pipe Diameter 

The internal pipe diameter of the inlet pipe. 
•  Outlet Pipe Diameter 

The internal pipe diameter of the inlet pipe. 
•  Start Elevation 

The height of the inlet pipe above ground level. 
•  End Elevation 

The height of the outlet pipe above ground level. 

Calculate Performs the calculation and displays any results in the Results field. 

OK Saves the calculation and the entered data to the tree view. 
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2.2.2. Isothermal Calculation – Conduits Tab 
Through the display, conduit types and data can be entered, removed and sorted in the order the 
pipeline system and components are assembled. 
 

Figure 4  Conduits dialogue 

The following selections can be made from this dialogue: 
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Usage 
Conduit Type Mandatory. 

The following Conduit Types can be selected: 
•  Pipe Straight 
•  Sudden Contraction 
•  Sudden Expansion 
•  Orifice Plate 
•  Elbow 
•  Gate Valve 
•  Globe Valve 
Enter values for: 
•  Diameter 
•  Orifice Diameter 
•  Absolute Diameter 
•  Length 
•  Upstream Diameter 
•  Downstream Diameter 
•  Number Off. 
Certain boxes may be greyed out depending on the Conduit Type 
selected. 

This button is used to Add a conduit to the list. 
•  Select one of the seven conduit types from the pull down list (for 

example, Pipe Straight). 
•  Enter data appropriate to the conduit selected. 
•  Click on the Add button to add the conduit. 

Add 

Note. Ensure that all fields have data entered or the conduit will not 
be added to the list. 

Remove This button is used to Remove a conduit from the list. 
Select the conduit from list on left-hand then click on the Remove 
button to remove from list. 

Up / Down This button is used to reorder the Conduit list. 
Select the conduit from the list on left-hand side then use the Up � and 
Down � buttons to reposition it in the list. 
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2.3. Laminar Calculation 
Used to calculate pressure drop and heat transfer for laminar flow in straight pipes. Either wall 
temperature or wall heat flux boundary conditions can be specified. 
 
Click on the plus sign to expand the tree, the minus sign to collapse it and click on the calculation 
in the list to display it. 

Note. Clicking on a calculation from the tree view more than once will duplicate an instance of 
it and make it available for comparing results with slight modifications to input. 

 

Figure 5  Laminar Calculation dialogue 

The following selections can be made from this dialogue: 
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Usage 
Description of 
calculation 

Mandatory. 
Enter a text string to identify the calculation. 

Fluid Density Mandatory. 
The actual density of the fluid at operating temperatures. 

Calculation Method Mandatory. 
Select from either Newtonian Fluid or Generalised Bingham. 
The following selections are available when Newtonian Fluid is 
selected: 
Viscosity Settings 
•  1st and 2nd Viscosity Values 
•  1st and 2nd Temperature Points. 
Heat Settings 
•  Heat Capacity 
•  Thermal Conductivity 
•  Coefficient of Thermal Expansion 
•  Fluid Temperature. 
The following selections are available when Generalised Bingham is 
selected: 
Viscosity Settings 
•  TAUY 
•  KO 
•  N 
•  A 
•  TO. 
Heat Settings 
•  Heat Capacity 
•  Thermal Conductivity 
•  Coefficient of Thermal Expansion 
•  Fluid Temperature. 

Calculate Performs the calculation and displays any results in the Results field. 

OK Saves the calculation and the entered data to the tree view. 

Results The field where the calculated results are displayed (see Figure 13 for 
an example). 
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2.3.1. Laminar Calculation – Additional Details Tab 
Used to add additional details for the Laminar calculation. 
 

Figure 6  Additional Details dialogue 

The following selections can be made from this dialogue: 
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Usage 
Flow Rate Mandatory. 

Enter a value for the flow rate down the pipe. 

Pipeline Details Mandatory. 
Enter values for: 
•  Pipe Diameter 
•  Pipe Length 
Wall Boundary 
Select from either: 
•  Wall Temperature Spec 
•  Wall Heat Flux Spec 
Wall Condition 
The following selection can be made when Wall Temperature Spec is 
selected from the drop down menu: 
•  Wall Temperature (greyed out when Wall Heat Flux Spec is 

selected). 
The following selection can be made when Wall Heat Flux Spec is 
selected: 
•  Wall Heat Flux (greyed out when Wall Temperature Spec is 

selected). 

Radial and Axial 
Settings 

Enter values for: 
•  Number of Radial Increments 
•  Axial Dimensionless Step. 
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2.4. Turbulent Calculation 
Used to calculate pressure drop and heat transfer for turbulent flow in straight pipes. 
 
Click on the plus sign to expand the tree, the minus sign to collapse it and click on the calculation 
in the list to display it. 

Note. Clicking on a calculation from the tree view more than once duplicates an instance of it 
and makes it available for comparing results with slight modifications to input. 

 

Figure 7  Turbulent Calculation dialogue 

The following selections can be made from this dialogue: 
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Usage 
Description of 
calculation 

Mandatory 
Enter a text string to identify the calculation. 

Fluid Density Mandatory. 
The actual density of the fluid at operating temperatures. 

Calculation Method Mandatory. 
Select from either Newtonian Fluid or Generalised Bingham. 
The selections available when Newtonian Fluid is selected: 
Viscosity Settings 
•  Viscosity at bulk Temperature. 
Heat Settings 
•  Heat Capacity 
•  Thermal Conductivity. 
The selections available when Generalised Bingham is selected: 
Viscosity Settings 
•  TAUY 
•  K 
•  N 
Heat Settings 
•  Heat Capacity 
•  Thermal Conductivity. 

Calculate Performs the calculation and displays any results in the Results field. 

OK Saves the calculation and the entered data to the tree view. 

Results The field where the calculated results are displayed (see Figure 13 for 
an example). 
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2.4.1. Turbulent Calculation – Friction Parameters Tab 
Used to add additional details for the Laminar calculation. 
 

Figure 8  Friction Parameters dialogue 

The following selections can be made from this dialogue: 
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Usage 
Friction Factor Mode Mandatory. 

Use the drop down menu to select from: 
No Drag Reduction 
Enter a value for Flow Rate. 
Friction Factor versus Reynolds Number 
Enter values for: 
•  Flow Rate 
•  Reynolds Number 
•  Friction Factor. 
Notice that the Reynolds Number and Friction Factor are displayed as 
a grid. 
Friction Velocity versus Degree of Drag Reduction 
Enter values for: 
•  Flow Rate 
•  Friction Velocity 
•  Degree of Drag Reduction. 
Notice that the Friction Velocity and Degree of Drag Reduction are 
displayed as a grid. 

Flow Rate Mandatory. 
Enter a value. 

Pipeline Details Mandatory. 
Enter values for: 
Pipe Diameter 
Enter the required value or use the Pipe Inner Diameter Calculator (see 
section 2.5.3.1 for more information). 
Absolute Roughness 
Enter the required value or use the Pipe Roughness Calculator (see 
section 2.5.3.2 for more information). 

 
 
 



 
 

 

Page 26 of 50   VisFlo User Guide 
Document Version 1.4 – 24 October 2005 

2.5. VisFlo Menus 
This section lists the various VisFlo menus and describes the options that are available. 

2.5.1. File Menu 
The File menu allows the following options to be accessed: 
 
Menu Option Definition 
New Creates a new Isothermal, Laminar or Turbulent calculation (a maximum of 

four of each type can be created in one session). 
Open Opens a previously saved calculation. 
Save Saves the active calculation to file. 
Print Prints the active calculated results. 
Print Setup Defines the printer and properties required. 
Print Preview Previews the results file in a text editor. 
Exit Exits the VisFlo program. 

2.5.2. Options Menu 
The Options menu only allows the Default Units option to be accessed. This option changes the 
default units used for the majority of input fields. 
 

Figure 9  Default Application Units window 
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The following selections can be made: 

Usage 

 
New 
Creates a new default units template. 

 
Open 
Opens an existing default units template to use. 

 
Save 
Saves the current units template under a different file name. 

 
Save as Default Units 
Default Units can be selected from: 
•  Engineering 
•  British 
•  SI 
•  User Default 
The units can be changed and saved by performing the following: 
1. Click in the unit field and select the appropriate type from the pull down 

list. 
2. Click on the Save Default Units icon. 

Mass Units Mass Units can be specified as one of the following: 
g, kg, tonne, ton, US ton, cwt, lb or slug. 

Molar Units Molar Units can be specified as one of the following: 
mol, kmol, gmol or lbmol. 

� Clicking on the down arrow � to the right of the ‘Molar Units’ field displays 
an option ‘Add or Remove Buttons’ that allows the following menu options to 
be added or removed: 
•  New 
•  Open 
•  Save 
•  Save as default 
•  User: 
•  Mass Units: 
•  Molar Units: 
Resize toolbar and customise facilities are available. 
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2.5.3. Tools Menu 
The Tools menu allows the following options to be accessed: 
 
•  Pipe Inner Diameter Calculator 
•  Pipe Roughness Calculator. 
 
These are described in the following sections: 

2.5.3.1. Pipe Inner Diameter Calculator 
This dialogue is used to calculate the pipe inner diameter. 
 
Select a standard pipe size then the available schedules for that pipe size. The details for that 
combination are displayed at the bottom of the dialogue box. 
 

Figure 10  Pipe Inner Diameter Calculator dialogue 

The following selections can be made from this dialogue: 

Usage 
Standard Pipe Sizes Lists the pipe sizes available from 1/8″ to 36″. 

Schedules Available Lists the pipe schedules available for the pipe size selected. 

Inner Diameter Displays the Inner Diameter of the selected pipe. 

Wall Thickness Displays the Wall Thickness of the selected pipe. 

Outside Diameter Displays the Outside Diameter of the selected pipe. 

Return Use the radio button to indicate which selection is to be returned to 
the program. The default is Inner Diameter. 

OK Clicking on the OK button returns the chosen value to the program. 
The value is pasted into the cell that was highlighted when the Pipe 
Inner Diameter Calculator was selected. 
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Procedure 
1. Click in the field where the pipe inner diameter values are to be placed. Go to the Tools menu 

and select Pipe Inner Diameter Calculator. 
 

2. Select the required pipe size and schedule then click the Return radio button to the right of 
the Inner Diameter box to return the values. 
 

3. Click on OK. The values are automatically pasted into the field. 

2.5.3.2. Pipe Roughness Calculator 
This calculator is used to select a Surface Type and Absolute Roughness. Clicking on OK then 
adds the selection to the calculation. 
 
The units of measurement for roughness depend on the program calling the Pipe Roughness 
Calculator. Those for PIPER are in mm. For other programs (for example, FLONET) the Pipe 
Roughness Calculator displays and returns the relative roughness based on the relevant pipe 
diameter. 
 
By default, the units are in mm for PEW and the Absolute Roughness is returned. 
 

Figure 11  Pipe Roughness Calculator dialogue 

Procedure 
1. Click in the field where the absolute roughness value is to be placed. Go to the Tools menu 

and select Pipe Roughness Calculator. 
 

2. Select the required surface type. 
 

3. Click on OK. The value is automatically pasted into the field. 

2.5.4. Window Menu 
The Window menu allows the following standard Windows options to be accessed: 
 
•  Tile (horizontal and vertical) 
•  Cascade. 
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2.5.5. Help Menu 
The Help menu allows the following options to be accessed: 
 
•  Access the VisFlo help menu for Contents, Index and Search 
•  Link to the Technical Support topic within the help system 
•  Access the ABB web site 
•  Access the PEL Helpdesk web site for reporting problems 
•  View the About VisFlo dialogue. 
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2.6. The VisFlo Toolbar 
The buttons on the toolbar allow the following options to be selected: 
 

Button   Purpose 

 

New Calculation 
Creates a new Isothermal, Laminar or Turbulent calculation. 

 Equivalent File menu item − New 

� Clicking on the down arrow � next to the ‘New Calculation’ button displays the 
More Tools menu that allows the following menu options to be added or removed: 
•  Isothermal 
•  Laminar 
•  Turbulent. 

Open VisFlo Calculation File 
Opens a previously saved calculation. 

 Equivalent File menu item − Open 

 

Save Calculation Results File 
Saves the active calculation to file. 

 Equivalent File menu item − Save 

 

Print Calculation Results File 
Prints the active calculated results. 

 Equivalent File menu item − Print 

 

View Current Calculation Results 
Previews the results file in a text editor. 

 Equivalent File menu item − Print Preview 

 

Configure Default Units for Input 
Changes the default units used for the majority of input fields. 

 Equivalent Options menu item − Default Units 

Exit VisFlo 
Exits the VisFlo program. 

 Equivalent File menu item − Exit 

� Clicking on the down arrow � next to the ‘Exit VisFlo’ button displays the More 
Tools menu that allows the following menu options to be added or removed: 
•  New 
•  Open 
•  Save 
•  Print 
•  Print Preview 
•  Default Units 
•  Exit. 
Resize toolbar and customise facilities are available. 
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3. VisFlo Tutorial 

3.1. General 
This tutorial contains examples of how to use VisFlo. These are: 
 
Example 1 − Creating an Isothermal Pressure Drop Calculation 
Example 2 − Creating a Laminar Flow Heat Transfer Calculation 
Example 3 − Creating a Turbulent Flow Heat Transfer Calculation. 
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3.2. Example 1 – Creating an Isothermal Pressure Drop Calculation 
For steady flow of a liquid in a pipe system between sections 1 and 2, a mechanical energy balance 
can be written as: 
 

1
1

1
2

1
2

2
2
2

2
P
g

V
2g Z

P
g

V
2g Z h

ρ α ρ α Σ +  +  =  +  +  + 

 
where: 
 

P = absolute pressure 
V = velocity 
Z = elevation above an arbitrary datum 
α = kinetic energy correction factor 
Σ h = the sum of the head losses for all straight pipe sections and all fittings. 

 
Either pressure drop or flowrate can be specified and the other calculated. Details of the 
calculation procedures and correlations used are given in Chapter 3 of the non-Newtonian flow 
design guide. 

Example: 
The following example illustrates the use of VisFlo for isothermal pressure drop calculations. 
 
A non-Newtonian liquid is to be transferred under gravity flow from a header tank to a lower tank. 
The pipeline is 15m long with an inner diameter of 0.0762m.  
 
A schematic representation of the pipe system is shown in Figure 12 below: 
 

Figure 12  Isothermal Pressure Drop Calculation example 
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3.2.1. Accessing VisFlo 

Procedure 
1. Access VisFlo by selecting Start | Programs | PEL | then click on the VisFlo icon (see left). 

 
2. A splash screen showing the program name and version number appears briefly before the 

start up screen (see Figure 1) is displayed. 

3.2.2. Adding the Isothermal data 

Procedure 
1. Go to the File menu and select New then ���� Isothermal. The Isothermal Calculation window 

is displayed. 
 

2. Enter a text string in the Description of calculation field to identify the calculation. 
 

3. Go to the Fluid Density field and enter 1000 kg/m3. 
 

4. Go to the Calculation Method field and select Generalised Bingham from the drop down 
list. 
 

5. Go to Viscosity Settings and enter the following values: 
 

TAUY: 1.0 
K: 0.011 
N: 0.9 

 
6. The Viscosity Settings fields now look like this: 

 

 
7. Go to the Calculation Mode field. Select Pressure Drop Fixed from the drop down list and 

enter the following values in the Flow Settings fields: 
 

Flow Rate: 1.0 kg/s 
Pressure Drop: 0.0 N/m2 
Flowrate Convergence: 0.01 kg/s 

 
8. The Flow Settings fields now look like this: 
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3.2.3. Adding the Pipeline Details data 

Procedure 
1. Click on the Pipeline Details tab and enter the following values in the fields displayed: 

 
Inlet Pipe Diameter: 3.0 m 
Outlet Pipe Diameter: 0.0762 m 
Start Elevation: 5.0 m 
End Elevation: 0.0 m 

 
2. The Pipeline Details data fields now look like this: 

 

3.2.4. Adding the Conduits data 

Procedure 
1. Click on the Conduits tab and enter the following values in the fields displayed: 

 
2. Go to the ‘Conduit Type’ drop down list and select Sudden Contraction. Enter the following 

values: 
 

Upstream Diameter: 3.0 m 
Downstream Diameter: 0.0762 m 
Number Off: 5.0 m 

 
3. Click on the Add button. Sudden Contract appears in the left-hand panel. 

 
4. Go to the ‘Conduit Type’ drop down list and select Pipe Straight. Enter the following values: 
 

Diameter: 0.0762 m 
Absolute Roughness: 0.0 m 
Length: 15.0 m 
Number Off: 1 

 
5. Click on the Add button. Pipe Straight appears in the left-hand panel. 

 
6. Select Gate Valve from the Conduit Type drop down list and enter the following values: 
 

Diameter: 0.0762 m 
Number Off: 1 

 
7. Click on the Add button. Gate Valve appears in the left-hand panel. 
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8. Select Elbow from the Conduit Type drop down list and enter the following values: 
 

Diameter: 0.0762 m 
Number Off: 2 

 
9. Click on the Add button. Elbow appears in the left-hand panel. 

 
10. Select Globe Valve from the Conduit Type drop down list and enter the following values: 

 
Diameter: 0.0762 m 
Number Off: 1 
 

11. The field to the left of the Conduit Type selector now looks like this: 
 

3.2.5. Performing the calculation 

Procedure 
1. Click on the Calculate button (see left). The results of the calculation are displayed in the 

Results field on the right-hand side of the screen as shown below: 
 

Figure 13  Isothermal Calculation Results (part of) 

2. A paper copy of the results can be printed either by clicking on the Print toolbar button (see 
left) or go to the File menu and select Print. The complete results file is printed in the format 
shown on the following page. 

Note. The output units shown in the results are predetermined and cannot be changed. 
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ISOTHERMAL PRESSURE DROP CALCULATION/ ********************************

FLUID DENSITY = 1000.0 KG/M3
YIELD STRESS (TAUY) = 0.1000E+01 KG/M.SEC
CONSISTENCY INDEX (K) = 0.1100E-01 KG/M.SEC**2-N
FLOW BEHAVIOUR INDEX (N) = 0.90
PRESSURE DROP FIXED = 0.0000E+00 N/M2
INLET DIAMETER = 3.0000 M
OUTLET DIAMETER = 0.0762 M
INITIAL ELEVATION = 5.0 M
FINAL ELEVATION = 0.0 M

CONDUIT NUMBER 1
-----------------
SUDDEN CONTRACTION
UPSTREAM DIAMETER = 3.0000 M
DOWNSTREAM DIAMETER = 0.0762 M
NUMBER OF ITEMS OF THIS TYPE = 1

CONDUIT NUMBER 2
-----------------
STRAIGHT PIPE
DIAMETER = 0.0762 M
ROUGHNESS = 0.0000E+00 M
LENGTH = 15.0 M
NUMBER OF ITEMS OF THIS TYPE = 1

CONDUIT NUMBER 3
-----------------
GATE VALVE
DIAMETER = 0.0762 M
NUMBER OF ITEMS OF THIS TYPE = 1

CONDUIT NUMBER 4
-----------------
ELBOW
DIAMETER = 0.0762 M
NUMBER OF ITEMS OF THIS TYPE = 2

CONDUIT NUMBER 5
-----------------
GLOBE VALVE
DIAMETER = 0.0762 M
NUMBER OF ITEMS OF THIS TYPE = 1

1CONDUIT HEAD LOSSES
-------------------

-----------------------------------------------------------------
: CONDUIT : CONDUIT : VELOCITY : REYNOLDS :NUMBER OF : HEAD :
: NUMBER : TYPE : (M/SEC) : NUMBER : VELOCITY : LOST :
: : : : : HEADS : (M) :
: : : : : LOST : :
-----------------------------------------------------------------
: 1 : 2 : 1.65 : 1.98E+04 : 0.72 : 0.10 :
: 2 : 1 : 1.65 : 1.98E+04 : 5.04 : 0.70 :
: 3 : 6 : 1.65 : 1.98E+04 : 2.10 : 0.29 :
: 4 : 5 : 1.65 : 1.98E+04 : 0.90 : 0.12 :
: 5 : 7 : 1.65 : 1.98E+04 : 25.40 : 3.52 :
-----------------------------------------------------------------

-----------------------------------------------------------------
: CONDUIT : CONDUIT : VELOCITY : REYNOLDS : WALL : APPARENT :
: NUMBER : TYPE : (M/SEC) : NUMBER : SHEAR : VISCOSITY:
: : : : : RATE : (N.S/M2) :
: : : : : (1/S) : :
-----------------------------------------------------------------
: 1 : 2 : 1.65 : 1.98E+04 : 1.11E+03 : 7.85E-03 :
: 2 : 1 : 1.65 : 1.98E+04 : 1.11E+03 : 7.85E-03 :
: 3 : 6 : 1.65 : 1.98E+04 : 1.11E+03 : 7.85E-03 :
: 4 : 5 : 1.65 : 1.98E+04 : 1.11E+03 : 7.85E-03 :
: 5 : 7 : 1.65 : 1.98E+04 : 1.11E+03 : 7.85E-03 :
-----------------------------------------------------------------
CALCULATED FLOWRATE = 7.52 KG/SEC
CALCULATED PRESSURE DROP = 1.2686E+01 N/M2
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igure 14  Isothermal Calculation Results 
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3.3. Example 2 – Creating a Laminar Flow Heat Transfer Calculation 
This procedure describes the steps to generate a Laminar Flow Heat Calculation. 
 
Details of the calculation procedure and correlations used in the laminar flow heat transfer 
calculation are given in Chapter 6 of the non-Newtonian flow design guide. The calculation takes 
account of the variation of viscous properties with temperature and internal heat generation from 
viscous dissipation. 
 
Two alternative boundary conditions can be specified: 
 
1. Constant wall temperature 

 
2. Constant wall heat flux (a positive value indicates heat input). 

Example: 
A molten polymer at an initial temperature of 200 degrees C is to be pumped through a straight 
pipe 1m long with an Inner Diameter of 0.01288m. There is to be no heat flux through the pipe 
wall. 

3.3.1. Adding the Laminar Heat Transfer data 

Procedure 
1. Access VisFlo as described in section 3.2.1. 

 
2. Go to the File menu and select New then ���� Laminar. The Laminar Calculation window is 

displayed. 
 

3. Enter a text string in the Description of calculation field to identify the calculation. 
 

4. Go to the Fluid Density field and enter 766.0 kg/m3. 
 

5. Go to the Calculation Method field and select Generalised Bingham from the drop down 
list. 

 
6. Go to Viscosity Settings and enter the following values: 

 
TAUY: 0.0 
KO: 0.011 
N: 37000.0 
A: 7766.30 
N: 140.0 
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9. The Viscosity Settings fields now look like this: 
 

 
10. Go to Heat Settings and enter the following values: 

 
Heat Capacity: 2189.00 
Thermal Conductivity: 0.2412 
Coefficient of Thermal Expansion: 0.0 
Fluid Temperature: 200.0 

 
11. The Heat Settings fields now look like this: 
 

3.3.2. Adding Additional Details 

Procedure 
1. Go to the Flow Rate field and enter 000347 kg/s. 

 
2. Go to Pipeline Details and enter the following values: 

 
Pipe Diameter: 0.01288 m 
Pipe Length: 1.0 m 

 
3. Go to the Wall Boundary field and select Wall Heat Flux Spec from the drop down list. 

 
4. Go to Wall Conditions and enter the following value: 

 
Wall Heat Flux: 0.0 

 
5. Go to Radial and Axial Settings and enter the following values: 

 
Number of Radial Increments: 0.0 
Axial Dimensionless Step: 0.0 
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3.3.3. Performing the calculation 

Procedure 
1. Click on the Calculate button (see left). The results of the calculation are displayed in the 

Results field on the right-hand side of the screen as shown below: 
 

Figure 15  Laminar Calculation Results (part of) 

2. A paper copy of the results can be printed either by clicking on the Print toolbar button (see 
left) or go to the File menu and select Print. 
 
The complete results file is printed in the format shown on the following page. 

Note. The output units shown in the results are predetermined and cannot be changed. 
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LAMINAR HEAT TRANSFER CALCULATION/ *********************************

FLUID DENSITY = 766.0 KG/M3
YIELD STRESS (TAUY) = 0.0000E+00 KG/M.SEC
CONSISTENCY INDEX (K) = 0.3700E+05 KG/M.SEC**2-N
FLOW BEHAVIOUR INDEX (N) = 0.37
TEMP DEPENDENCE PARAMETER (A) = 0.7766E+04 K
REFERENCE TEMPERATURE (TO) = 140.00 DEG C
HEAT CAPACITY = 2189.0 J/KG.K
THERMAL CONDUCTIVITY = 0.2412 W/M.K
COEFF OF THERMAL EXPANSION = 0.0000 /DEG C
PIPE DIAMETER = 0.0129 M
PIPE LENGTH = 1.00 M
FLOWRATE = 0.0035 KG/SEC
INLET TEMPERATURE = 200.00 DEG C
WALL HEAT FLUX = 0.0000E+00 W/M**2
NUMBER OF RADIAL INCREMENTS = 100
AXIAL STEP LENGTH = 0.1000E-06

FLUID VELOCITY = 0.035 M/SEC
REYNOLDS NUMBER = 0.2240E-04
PRESSURE DROP = 0.1517E+08 N/M**2

FINAL VELOCITY PROFILE ( CENTRE TO WALL IN M/SEC ) :

0.052 0.052 0.052 0.052 0.051 0.051 0.051 0.051 0.051
0.051 0.051 0.051 0.051 0.051 0.051 0.051 0.051 0.050
0.050 0.050 0.050 0.050 0.049 0.049 0.049 0.048 0.048
0.047 0.047 0.046 0.045 0.044 0.043 0.042 0.041 0.040
0.039 0.037 0.035 0.034 0.032 0.029 0.027 0.024 0.022
0.019 0.015 0.012 0.008 0.004 0.000

NUSSELT NUMBER = 0.00
HEAT TRANSFER COEFFICIENT = 0.00 W/M**2 K
FINAL BULK TEMPERATURE = 209.14 DEG C

FINAL TEMPERATURE PROFILE ( CENTRE TO WALL IN DEG C ) :

201.5 201.6 201.6 201.6 201.6 201.7 201.8 201.9 202.0
202.1 202.2 202.4 202.5 202.7 202.9 203.1 203.3 203.6
203.9 204.2 204.5 204.8 205.2 205.6 206.0 206.4 206.9
207.3 207.8 208.4 208.9 209.4 210.0 210.6 211.2 211.8
212.4 213.0 213.6 214.2 214.8 215.4 215.9 216.4 216.9
217.3 217.7 218.0 218.2 218.3 218.4
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igure 16  Laminar Calculation Results 
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3.4. Example 3 – Creating a Turbulent Flow Heat Transfer Calculation 
Details of the calculation procedure and correlations used in the turbulent flow heat transfer 
calculation are given in Chapter 7 of the non-Newtonian flow design guide. Fluid properties at the 
average bulk temperature should be used. 
 
Friction factors can be determined by one of three different methods: 
 
1. Colebrook-White equation for friction factor versus Reynolds number 

 
2. User supplied friction factor versus Reynolds number data 

 
3. User supplied degree of drag reduction versus friction velocity data. 
 
Reynolds numbers are based on the apparent viscosity at the wall. If user supplied data are to be 
used, a maximum of 20 data points can be entered and linear interpolation is carried out between 
data points. 
 
This procedure describes the steps to generate a Laminar Flow Heat calculation. 
 
The following example illustrates the use of VisFlo to determine. 

Example: 
A slurry is known to be not subject to drag reduction and is to be heated on the tube side of a shell 
and tube heat exchanger. The tube Inner Diameter is 0.02 m and the Flowrate in each tube is 0.5 
kg/sec. 

3.4.1. Adding the Turbulent Heat Transfer data 

Procedure 
1. Access VisFlo as described in section 3.2.1. 

 
2. Go to the File menu and select New then ���� Turbulent. The Turbulent window is displayed. 

 
3. Enter a text string in the Description of calculation field to identify the calculation. 

 
4. Go to the Fluid Density field and enter 1050.0 kg/m3. 

 
5. Go to the Calculation Method field and select Generalised Bingham from the drop down list. 

 
6. Go to Viscosity Settings and enter the following values: 

 
TAUY: 0.0 
KO: 0.001 
N: 0.95 
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7. The Viscosity Settings fields now look like this: 
 

 
8. Go to Heat Settings and enter the following values: 

 
Heat Capacity: 4200.00 
Thermal Conductivity: 0.6 

 
9. The Heat Settings fields now look like this: 

 

3.4.2. Adding Friction Parameters data 

Procedure 
1. Go to the Friction Factor Mode field and select No Drag Reduction from the drop down 

list. 
 

2. Go to the Flow Rate field and enter 0.500 kg/s. 
 

3. Go to Pipeline Details and enter the following values: 
 

Pipe Diameter: 0.02 m 
Pipe Length: 0.0 m 

 
4. The Friction Parameters dialog now looks like this: 
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3.4.3. Performing the calculation 

Procedure 
1. Click on the Calculate button (see left). The results of the calculation are displayed in the 

Results field on the right-hand side of the screen as shown below: 
 

Figure 17  Turbulent Calculation Results (part of) 

2. A paper copy of the results can be printed either by clicking on the Print toolbar button (see 
left) or go to the File menu and select Print. 
 
The complete results file is printed in the format shown on the following page: 

Note. The output units shown in the results are predetermined and cannot be changed. 
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TURBULENT HEAT TRANSFER CALCULATION
***********************************

FLUID DENSITY = 1050.0 KG/M3
YIELD STRESS (TAUY) = 0.0000E+00 KG/M.SEC
CONSISTENCY INDEX (K) = 0.1000E-02 KG/M.SEC**2-N
FLOW BEHAVIOUR INDEX (N) = 0.95
HEAT CAPACITY = 4200.0 J/KG.K
THERMAL CONDUCTIVITY = .6000 W/M.K
PIPE DIAMETER = .0200 M
PIPE ROUGHNESS = 0.0000E+00 M
FLOWRATE = .5000 KG/SEC

FLUID VELOCITY = 1.516 M/SEC
REYNOLDS NUMBER = 0.5042E+05
FRICTION FACTOR = 0.5181E-02
B-COEFFICIENT = 5.100

PRANDTL NUMBER = 4.42
NUSSELT NUMBER = 274.74
HEAT TRANSFER COEFFICIENT = 8242.11 W/M**2 K
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Figure 18  Turbulent Calculation Results 
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Appendices 

Appendix A – Field Input 
There are two standard field entries − a text box field and a unit field box. Both of these allow the 
user to click into or tab to then and enter data. 

The Text Box 
The text box is typical of each calculation and is used to enter a textual description of the type of 
calculation. 
 

 
The next text box is set up to allow numerical data such as 1,2,40, etc. 
 

The Unit Field Box 
The unit field box comprises of an input box and a unit pull down list. The entered value is 
dependant on the unit shown. 
 

 
Enter a value followed by a unit parameter which is converted automatically to the displayed unit 
either when the return key is pressed or the cursor is moved to another field.  
 
In the following example 3.0 inches is entered and becomes 0.0762 m. 
 

 
becomes: 
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The displayed unit can be changed by clicking on it and selecting from the displayed list (see 
example below). This has the effect of automatically changing any value entered in the field to the 
new unit type. 
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Notes 
Use these pages to record any notes. 
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Notes 
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